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Extron Certified DSP Bundle for Microsoft® Teams® 
Rooms – Large Room • Setup Guide

IMPORTANT NOTE:              	  
Go to www.extron.com for the complete user guide, installation instructions, and specifications.

Microsoft Teams and Extron have come together to provide Teams Rooms solutions with our certified hardware. Now it is easier 
than ever to stay connected with flexibility of realtime collaboration from anywhere. The products in our Teams Rooms Certified 
Design Solutions have been designed and meticulously tested for best-in-class performance and ease of use.

Requirements
Extron Equipment List

Product Description Quantity
DMP 128 Plus C V AT 12x8 Digital Matrix Processor w/ AEC, VoIP, & Dante® 1
XPA U 1004 SB Four Channel Bridgeable Output Amp, 100/200 Watts 1
IPCP Pro 255Q xi Control Processor with LinkLicense UI upgrade 1
SF 26CT LP 6.5” Low profile, 2-way Ceiling Speakers, pair 2
RSU 129 1U 9.5" Deep Universal Rack Shelf, Gray 1
SPK14P	14 AWG Plenum Speaker Cable - 150' (45.7 m) 1
USB CFG cable USB A Male to USB Mini B Male 6' (1.8 m) 1
MLC PW Audio cable Audio patch cable for audio DSP output to amplifier input - 6' (1.8 m) 1
Network cable UTP RJ-45 Cat-5e Plenum network cable - 50' (15.2 m) 1
Network cable Cat-6 cable non Plenum - 6' (1.8 m) 2

Sennheiser® Equipment List
Product Description Quantity
TeamConnect Ceiling Medium Beamforming Ceiling Microphone array 1

		

Additional Required Equipment
Product Description Quantity
Teams Rooms computer Teams Rooms computer with camera and control interface 1
Network switch 10-port PoE network switch 1
Windows® computer or laptop Computer MUST contain the following:

•	 Extron DSP Configurator
•	 Extron Global Configurator Plus and Professional
•	 Extron Toolbelt
•	 Dante Controller
•	 Sennheiser Control Cockpit
•	 Extron system configuration *.zip files
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NOTE:	 The Windows computer or laptop is required for adjustments and can be disconnected after system configuration.

https://www.extron.com
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Figure 1.	 System Diagram Example

NOTE:	 The supplied network switch is manageable. However, the default configuration is sufficient for this solution to 
function.

figure 1
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Installation Details

Audio Cables
See figure 2 for the connections needed between the DMP Plus and the XPA U amplifier. Use the supplied balanced audio cable to 
connect each product.

XPA U 5-pole
Balanced Dual Mono Input

Tip
Ring

Sleeve (s)
Tip

Ring

L
R

Do not tin 
the wires!

DMP Plus 3-pole
Audio Output wiring

Balanced Output

Tip
Ring

Sleeve

Figure 2.	 Captive Screw Audio Cable Wiring

Amplifier and Speaker Installation
During installation of the amplifier and speakers, please ensure that their settings are compatible. Set the XPA U amplifier Output 
Mode to Bridged Mono, 70V. Set each SF 26CT LP rotary tap selector switch to 70 V, 16W.
For detailed setup instructions please see the XPA Ultra Series Setup Guide and SF 26CT LP Setup Guide at www.extron.com.
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Figure 3.	 Adjusting the Speaker

Configuration Overview
1.	 Unbox and connect the provided hardware using the diagram in figure 1 on page 2.

NOTE:	 Do not connect the USB cable between the Microsoft Teams Rooms computer and Extron DMP Plus until after 
the Extron DMP Plus is completely configured.

2.	 Install the following software utilities on the computer:
•	 Extron DSP Configurator Software
•	 Extron Global Configurator Plus and Professional
•	 Extron Toolbelt
•	 Dante Controller Software
•	 Sennheiser Control Cockpit Software

3.	 Download the following from the Extron website (www.extron.com):
•	 Extron Large Conference Room System File .zip folder

https://www.extron.com
https://www.extron.com
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Sennheiser TeamConnect Ceiling Medium Setup

Sennheiser TeamConnect Ceiling Medium
A single network cable connection from the Sennheiser TeamConnect Ceiling Medium (TCC M) to the network switch supports PoE 
into the microphone, Dante audio, and LED feedback for call and mute status. The browser-based Control Cockpit interface detects 
and identifies the TCC M when the network cable is attached to the PoE IN/Ctrl port and the microphone is powered on.

Figure 4.	 Control Cockpit Interface

From this interface, carry out the following actions:
•	 Setting Network Settings
•	 Beam-steering and Exclusion Zone Adjustments (Optional)

Setting Network Settings
Select the Network tab to configure and document the IP address and host name of the device. This is required later.

Figure 5.	 Control Cockpit Network Interface

figure 4
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Setting Up Third-party Access

Figure 6.	 Setting up Third-party Access

1.	 Select the Access tab to enable 3rd Party Access and configure a 3rd party Password. 
2.	 Document the 3rd party password for the device. This is required later.

Beam-steering and Exclusion Zone Adjustments (Optional)
If additional settings are required to reduce background noise of items such as HVAC, projector fans, or credenzas, the TCC M has 
a Priority Zone and up to five Exclusion Zones, which can be leveraged to remove these from the microphone pickup.
To configure a zone:
1.	 Select the desired unit from the Device List (see figure 4 on page 4). A Properties dialog box opens.
2.	 Select the Zones tab. The 3D Overall View shows the real-time focus of the TCC M automatic beam-steering (see figure 7).
3.	 Enable a Priority Zone or Exclusion Zone.
4.	 Edit the vertical and horizontal angles of the selected exclusion zones (see figure 8) to remove the observed noise.

NOTE:	 Refer to the TeamConnect Ceiling Medium instruction manual for more information.

    

Figure 7.	 Control Cockpit Zones Tab Figure 8.	 Control Cockpit Exclusion 
Zones Adjustment
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Dante Controller Setup
Dante Controller from Audinate® is required to route transmitters and receivers, and can be used to configure Dante settings and 
monitor performance.

Creating Subscriptions Between the Sennheiser TCC M and the Extron DMP 128 Plus C V AT
1.	 Ensure the laptop, DMP 128 Plus C V AT (Dante), and TCC M (Dante) are connected to the same network.
2.	 From the Windows Start menu select: All Programs > Audinate > Dante Controller. The Dante Controller - Network 

View screen opens. The Dante Controller auto-discovers Dante devices on the network and advertises itself to allow other 
Dante-enabled devices to communicate with it. Transmitters connect to receivers using the subscription matrix.

Figure 9.	 Routing Tab of the Dante Controller Network View

NOTE:	 The DMP 128 Plus C V AT and TCC M Dante connections are set to DHCP by default. If they cannot be 
discovered, ensure the correct interface is selected on the PC by selecting Interfaces from the File menu.

3.	 Open the Device View of the DMP 128 Plus C V AT by double-clicking the device name in the Receivers list.
4.	 In the Receive tab, click on the first channel name and rename it TCCM-A.

Figure 10.	 Receive Tab of the DMP Plus Device View
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5.	 Select the Transmit tab.
6.	 Click the first channel name and rename it TCCM Ref.

Figure 11.	 Transmit Tab of DMP Plus Device View

7.	 Select the Device Config tab and rename the DMP 128 Plus C V AT as desired.
8.	 Click Apply.

Figure 12.	 Device Config Tab of DMP Plus Device View

9.	 From the Device View drop-down menu, choose the TCC M device (see figure 13, 1).
10.	 In the Device Config tab, rename the TCC M microphone to TCCM-A.

Figure 13.	 Device Config Tab of TCC M Device View
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11.	 Close the Device View window and return to the Network View window.
12.	 To show the receivers of the DMP Plus device, click the + box next to the desired device in the Receivers list. The + sign 

changes to a - sign when the list expands.

13.	 Click the intersections of the desired subscriptions between transmitter and receiver channels (see figure 14, 1).

Figure 14.	 DMP Plus Subscriptions to TCC M

14.	 To show the transmitters of the TCC M, click the + box next to the desired device in the Dante Receivers panel (see 
figure 14). The + sign changes to a - sign when the device expands.

15.	 Click the intersections of the desired subscriptions between transmitter and receiver channels (see figure 15, 1).

Figure 15.	 TCC M Subscriptions to DMP Plus

NOTES:
•	 The  FarEndOut transmitter channel of the TCC M device should be routed to the first receiver channel of the 

DMP 128 Plus C V AT. A check mark at the intersection indicates the subscription is made. A check mark also 
appears next to the receive channel.

•	 The TCC M Ref transmitter channel of the DMP 128 Plus C V AT should be routed to the FarEndRef receiver 
channel of the TCC M.
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Extron DMP 128 Plus C V AT Setup
To configure the Extron DMP 128 Plus C V AT, perform these steps:
1.	 Set IP address via embedded web page.
2.	 Set the computer or laptop IP address within the range of the product IP address. The default settings are (LAN for non-V 

models, LAN 1 for V models):
•	 IP Address: 192.168.254.254
•	 Subnet: 255.255.255.0
•	 Gateway: 0.0.0.0

3.	 From a web browser, enter the device IP address into the address field.

NOTE:	 If the local system administrators have not changed the IP address, and the device has not been assigned an IP 
address via DHCP, the default address (LAN for non-V models, LAN 1 for V models) is 192.168.254.254.

4.	 Press Enter.
5.	 On the login page, enter admin as the Username, enter the Password (if one has been set), and click Sign In.

•	 By default, the password is the product serial number.
•	 If a Full Factory Reset has been performed, then the password is clear and the Password field can be left blank.

Figure 16.	 Login Page

6.	 The Communications Settings panel displays TCP/IP communication settings. Click Edit to open the Communication 
Settings dialog box and edit the TCP/IP settings.
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The following can be edited: DHCP status, IP address, subnet mask, and default gateway. This dialog box also displays the 
device MAC address. To revert the computer IP address to a range which can communicate to the new IP address schema.

NOTE:	 If DHCP is enabled, IP address, subnet mask, and default gateway cannot be edited.

Figure 17.	 Communications Settings Panel

To push the DSP Template file to the DMP Plus:
1.	 Open the Extron DSP Template file (downloaded previously in .zip file) with DSP Configurator software.
2.	 Connect to a DMP 128 Plus C V AT in Live Mode by clicking the Live button in the menu bar of DSP Configurator (see 

figure 18, 1). Alternatively, select Tools > Connect to Device or press <F6> on the keyboard. The Connect to Device 
dialog box opens.

Figure 18.	 Live Button

3.	 Click the TCP/IP tab in the dialog box.
4.	 Enter the IP address of the device in the Hostname or IP Address field. If necessary, enter the device password in the 

Password field.
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5.	 When a connection type with a device is established, the Synchronize with Device dialog box opens. Select Push.

Synchronize with DeviceDSP

NOTE: Pushing presets may cause the device to
cycle through each preset that is pushed. This
should not be performed during live operation.

CancelOK

Selected

All

Push Presets

Push AT Input Channel Names

Push Configuration

Push the data from this configuration to device, overwriting any data
currently in it. The device will disconnect after the push if the
configuration and all the presets are not sent.

Pull data from the device and update this configuration.

You have elected to change from Emulate mode to live mode. The data in
this configuration must be synchronized with the data in the device. Please
select an option below to continue:

Figure 19.	 Synchronize with Device Dialog Screen

6.	 Click OK.
Once the push is completed, the current state of the connected DMP 128 Plus C V AT is displayed in the DSP Configurator 
status panel and the device is ready for further configuration.

USB Naming
The USB Audio tab allows for customizing USB audio interface 
names and terminal types (see figure 20).

NOTE:	 Extron recommends configuring these settings 
before connecting USB audio devices to a PC.

To configure USB Audio settings in DSP Configurator:
1.	 From the Tools menu, select Device Settings. The 

Device Settings dialog box opens.
2.	 Click the USB Audio tab.
3.	 In the USB Name field, enter the desired name for the USB 

Audio interface.
4.	 In the USB Terminal Type panel, choose Echo Cancelling 

Speakerphone.
5.	 Click Apply to activate the new settings.
6.	 Connect the USB Audio port to the PC.

Device SettingsDSP ?

USB Name can be up to 32 characters drawn from the
alphabet (A-Z), digits (0-9), and special characters
including underscore(_), backslash(\), and spaces.

Unit Info IP Settings Passwords Serial Settings
Date/Time Dante DeviceUSB Audio

Cancel ApplyOK

Speakerphone

Echo Cancelling Speakerphone

Enter a USB Name for the USB Audio interface.
To restore the default name, clear the field and
click Apply.

USB Name :

USB 1 Terminal Type

Appear as:

Extron DMP Plus

Figure 20.	 USB Audio Tab
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Extron IPCP Pro 255Q xi Setup
The Control Procesor in this system facilitates the communication between the Extron DMP Plus and Sennheiser TCC M.

Get Ready
1.	 Download and install the latest version of the following software:

•	 Toolbelt — for discovering the control processor and other control products on the network, for managing core settings, 
and for upgrading firmware when needed.

•	 Global Configurator Plus and Professional (GCP) — for configuring the control system
2.	 Obtain network information for the unit from the network administrator. You also need the following details for each Extron Pro 

series Ethernet-enabled device:
•	 DHCP setting (on or off) •	 Subnet mask •	 Username
•	 LAN IP address •	 Gateway IP address •	 Passwords
•	 AV LAN IP address

NOTE: If DHCP is on, you do not need the IP addresses and subnet mask.

3.	 Write down the MAC address of each network interface on each IP Link Pro device to be used.
4.	 Obtain model names and setup information for devices the IPCP controls.

Mount and Cable All Devices
1.	 Cable devices to the control processor.
2.	 Connect power cords and power on all the devices.

Network Communication Setup
Network setup is essential prior to configuration. Use the flowchart at 
right as a guide to setting up the control processor for network use.

NOTE: If using 802.1X security, see the Extron 802.1X 
Technology Reference Guide and the Toolbelt Help file for 
additional details on system setup.

Open the Toolbelt software from within 
Global Con�gurator (GC Professional or 

GC Plus mode) or as the stand-alone 
application. 

Start Device Discovery.
Toolbelt displays a list of all Extron control 

devices connected to the network.

Using the MAC address, locate the desired 
control processor in the list and select it.

Network Communication Setup

Connect the PC and the LAN port or AV LAN 
port of the control processor to 

the same network.
Apply power to all devices.

For each network interface 
(LAN, or LAN and AV LAN), use the Set IP 

feature in Toolbelt or use the 
Toolbelt Manage > Network Settings tab 

feature to enter the IP address and 
subnet address, then con�gure other 

network settings as needed.



13

Extron Certified DSP Bundle for Microsoft® Teams® Rooms – Extra-Large Room • 
Setup Guide

Set Up the Control Processor for Network Communication.
1.	 Connect the PC to be used for setup and the LAN (or AV LAN) port of the control processor to the same Ethernet network.
2.	 Start Toolbelt and use it to discover the IPCP Pro 255Q xi:

Figure 21.	 Discover IPCP Pro 255Q xi with Toolbelt

3.	 Log on to the unit:

Figure 22.	 Log on to IPCP Pro 255Q xi

NOTES:
•	 The factory configured passwords for all accounts on this device have been set to the device serial number. 

Passwords can be changed during configuration. Passwords are case sensitive.
•	 If the device is reset to default settings, the password is the default password configuration. The default password is 

extron (for either admin or user accounts).

4.	 If required, change the password:

Figure 23.	 Change Password
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5.	 Set the DHCP status, IP address, subnet, gateway IP address, and related settings.

Figure 24.	 Configure Network Settings

NOTES:
•	 When setting up DHCP during network configuration or if using a host name instead of an IP address, the user must 

enter a qualified host name (Username.HostName.Domain). For example: somename.extron.com.
•	 A dedicated AV LAN safeguards AV systems from outside intrusion or interference by separating device control and 

other network traffic from a corporate or campus network. To ensure that the control processor LAN and AV LAN 
connections (ports) are connected to separate networks, the LAN and AV LAN IP address schemes must be on 
different subnetworks.

See the Network Communication Setup flow chart on page 12.
6.	 If required, apply a LinkLicense.

Figure 25.	 Apply LinkLicense
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Configure or Program the Control Processor

NOTE: See the Global Configurator Plus and Professional Help File as needed for step-by-step instructions and detailed 
information. The help file for GCP includes an introduction to the software and how to start a project and configuration.

Using Global Configurator, configure the control processor. The configuration tells the control processor:
•	 How its ports function •	 How its ports function
•	 How to control other products •	 When to do things
•	 Whom to notify, how, and under what circumstances

Configuration with GC Plus
1.	 Open the provided GC Plus configuration file. The software opens to Configuration view ( ). This option is also selectable 

from the View menu.

Figure 26.	 Configuration View — System Settings page for Control Processor

2.	 Set the IP address (see figure 26, 1), and Admin password (3) of the Control Processor, and, IP address for AV LAN (3).

NOTES:
•	 The factory configured passwords for all accounts on a device are set to the device serial number. Passwords are 

case sensitive.
•	 If the device is reset to default settings, the password is the default password configuration. The default password is 

extron.

3.	 Open the Communications Ports page (4).

Figure 27.	 Configuration View — Communications Ports page for DMP Plus

figure 27
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4.	 Choose DMP Plus under the Ethernet Ports list (see figure 27, 1, on page 15).

5.	 Set IP address (2) and Admin password of the DMP Plus device (3).

Figure 28.	 Configuration View — Communications Ports page for TCC M

6.	 Choose the TeamConnect Ceiling Medium under the Ethernet Ports list (see figure 28, 1).

7.	 Set IP address (2) and password (3) of the TCC M device.

8.	 Open Build Manager view (see figure 29, 1, ). This option is also selectable from the View menu.

Figure 29.	 Build Options panel

9.	 Under the Build & Upload section, click the Build button.
10.	 Wait for Verification. The Build and Upload bars show the progress.

Figure 30.	 Build and Upload Completed

11.	 Once the process is complete, the Build and Upload bars both show the message Complete (see figure 30).
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Test and Troubleshoot
Test the system (see the IPCP Pro Q xi and xi Series User Guide for an outline of the system testing procedure). Make adjustments 
to wiring or configuration as needed.

Microsoft Teams Rooms Setup
The Extron DMP 128 Plus connects to the Microsoft Teams Rooms system from the USB Audio port. Once the previous steps 
outlined in this document have been completed, please connect the Microsoft Teams Rooms system to the DMP 128 Plus USB 
Audio connection via the provided USB mini-B cable.
The following steps detail the required settings on the Microsoft Teams Rooms device:

Select Settings (see figure 31, 1) in the Microsoft Teams Rooms interface.

Figure 31.	 Microsoft Teams Rooms Setup

Microsoft Teams Rooms Interface Screen
Select the Extron DMP Plus (or configured USB Name in above steps) for each of the two parameters: Microphone (see 
figure 32, 1) and Speaker (2).

Figure 32.	 Microsoft Teams Rooms Interface

Microsoft Teams Rooms Settings Menu

NOTE:	 When using the Extron DMP 128 Plus, Microsoft Teams Rooms Rooms disables its internal acoustic echo 
cancellation (AEC) audio processing so that all audio processing is completed through the external DSP—the Extron 
DMP 128 Plus. This provides the best audio performance.
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Troubleshooting

DMP Plus Acoustic Echo Cancellation (AEC)

AEC Setup Overview
Proper gain structure involves the relationship between the signal at the selected reference and the signal at the mic input, within 
the context of proper levels for the reference and mic inputs independently. The mic input gain setting is naturally optimized for the 
voice level of the talker in that room. Therefore, the amount of signal from the far end that is picked up by the mic is dependent on 
how much that far end signal is being amplified in the near end room and the distance from the mic to the speakers.
The reference signal is the signal received from the far end, which arrives at the USB-assigned Aux Inputs of the DMP Plus. This is 
sent to the sound reinforcement system within the near end room, as well as a designated output channel to set the reference level 
for the DMP Plus AEC processor.

AEC Dialog
The AEC dialog in DSP Configurator contains meters and indicator LEDs that are essential for setting up gain structure and 
monitoring activity.

A	 AEC Activity Indicators (on the following page)
•	 Far – lights when activity is detected from the remote site.
•	 Near – lights when activity is detected from the local site.
•	 Update – lights when the AEC is updating (converging or reconverging)

B	 Meters
•	 ERL – the ratio in dB between the signal at the reference and the signal at the AEC 

channel input. When ERL is a positive number, the signal level at the AEC channel 
input is lower than the signal at the selected reference.

NOTE:	 The ideal level range for this meter is 0 to +15 dB. This ensures the right 
amount of reference signal is being sent through the AEC processor.

•	 ERLE – the amount in dB of potential echo signal that the AEC algorithm, not including 
NLP processing, is cancelling.

•	 TER – the sum of ERL + ERLE, in dB.

C	 Reference Selection List — The provided configuration includes a selected AEC 
reference. If necessary, a different AEC reference can be selected from the drop-down list.

D	 Noise  Cancellation Controls — Noise cancellation can be switched on or off from the 
AEC dialog. The noise canceller will detect steady state noise, such as HVAC or other 
continuous system noise, and effectively remove it without causing audible artifacts.

E	 Advanced AEC Controls — Click expand and collapse icon to expose the advanced AEC 
controls.
Advanced control functionality is as follows:
•	 Non-linear Processing (NLP) Controls: Figure 33.	 AEC Controls

•	 Enable NLP – This box is selected by default. Non-linear processing is necessary for the complete removal of echo.
•	 NLP Presets – Click a button to load a set of values to the three NLP parameters. If not using one of these presets, 

enter values into the fields for the following three controls:
•	 Max NLP Reduction – The maximum possible reduction in echo artifacts that can be applied
•	 Attack Time – The speed in which NLP is applied
•	 Release Time – The speed in which NLP is released
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•	 Additional Controls:
•	 Double Talk Echo Reduction – Sets the amount of echo reduction applied during double-talk (when two people 

speak at the same time).
•	 Comfort Noise – Sets a comfort noise level in dB to eliminate states of complete silence, which may be perceived as 

a failed connection.

Technical Support
For Extron technical support, visit: www.extron.com/company/contactus.aspx.
For Sennheiser technical support, visit: sennheiser.com/service-support.

https://www.extron.com/company/contactus.aspx
https://sennheiser.com/service-support
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For information on safety guidelines, regulatory compliances, EMI/EMF compatibility, accessibility, and related topics, see the Extron 
Safety and Regulatory Compliance Guide on the Extron website.
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